
МЕТОДИЧНІ ВКАЗІВКИ ДО ВИКОНАННЯ ПРАКТИЧНОЇ РОБОТИ 

Практична робота № 1 

Огляд інтерфейсу користувача АrcGIS 

Мета: Ознайомитись з основними елементами інтерфейсу користувача програми ArcGIS 

та вивчити основи роботи з геоінформаційною системою. 

Завдання: 

1. Ознайомитися з інтерфейсом програми ArcGIS. 

2. Навчитися використовувати основні інструменти для створення, редагування та 

візуалізації просторових даних. 

Теоретичні положення: ArcGIS — це одна з найбільш поширених платформ для роботи з 

геоінформаційними системами, що дозволяє виконувати просторовий аналіз, візуалізацію 

та управління просторовими даними. Інтерфейс програми поділений на кілька основних 

панелей, таких як панель інструментів, панель легенди, панель стану та карти, що 

дозволяє зручно організувати робочий процес. Знання інтерфейсу є основою для 

ефективного використання ArcGIS у різних сферах, від картографії до геологічних 

досліджень. 

Порядок виконання: 

1. Запуск програми ArcGIS: 

o Відкрийте програму ArcGIS. Зазвичай програма має головне вікно, яке 

поділено на кілька областей: меню, панелі інструментів, карта (основне 

вікно для роботи з даними), а також вкладки для налаштувань проекту. 

o Переконайтесь, що інтерфейс відображає всі необхідні панелі: "Catalog", 

"Table of Contents", "Tools", "Editor", тощо. 

2. Огляд основних елементів інтерфейсу: 

o Меню: Основне меню містить такі пункти, як "File", "View", "Insert", 

"Tools", "Window", що дають доступ до основних функцій програми. 

o Панель інструментів: Розташована в верхній частині вікна програми і 

містить основні кнопки для роботи з проектами, наприклад, для збереження, 

відкриття файлів, додавання нових шарів, а також інструменти для роботи з 

картами. 

o Панель інструментів "Table of Contents": Це панель, на якій 

відображаються всі шари карт, дані та атрибути, що використовуються в 

поточному проекті. 

o Панель карт: Центральна область, де відображається карта. Тут ви будете 

працювати з просторовими даними, переміщувати карту, змінювати 

масштаб та переглядати візуалізацію даних. 

o Панель "Catalog": Використовується для навігації та доступу до файлів та 

даних, що зберігаються на комп'ютері або в мережі. Тут можна знаходити 

різні типи файлів, що використовуються в ArcGIS, такі як шари даних, 

геодані, картографічні проекти тощо. 

3. Додавання нового шару даних: 

o Для початку роботи з картою потрібно додати дані, які ви хочете 

використовувати в аналізі. Перейдіть до панелі "Catalog", знайдіть файл, що 

містить потрібні дані, і перетягніть його на карту. 



o Зазначте, що дані повинні бути у форматі, сумісному з ArcGIS (наприклад, 

Shapefile, GeoTIFF, KML). 

4. Навігація по карті: 

o Для навігації по карті використовуйте панель інструментів, де є кнопки для 

збільшення, зменшення масштабу, переміщення по карті (панель "Zoom" і 

"Pan"). 

o Ознайомтесь з можливостями перегляду карти, зокрема, можливість 

перемикатися між різними шарами, налаштовувати їх видимість та стиль 

відображення. 

5. Редагування даних: 

o У програмі ArcGIS є можливість редагувати дані, використовуючи 

інструмент "Editor". Для цього необхідно вибрати шар, з яким ви хочете 

працювати, активувати режим редагування та внести необхідні зміни 

(додавання точок, ліній або полигонів, редагування атрибутів). 

6. Візуалізація та стилізація даних: 

o Розгляньте, як можна змінювати стиль відображення даних на карті. Для 

цього натискайте правою кнопкою миші на шарі та вибирайте "Properties", 

де можна змінювати кольори, типи ліній, прозорість та інші параметри 

візуалізації. 

7. Експорт та збереження карти: 

o Після завершення роботи з картою можна експортувати її у різні формати 

(наприклад, PNG, JPEG, PDF) для подальшого використання або друку. 

o Для цього виберіть пункт "File" -> "Export Map", де можна налаштувати 

формат і якість вихідного файлу. 

Оформлення результатів роботи: 

1. Під час виконання практичної роботи зробіть скріншоти інтерфейсу програми, які 

відображають важливі етапи роботи. 

2. Завершену карту збережіть у форматі, який підходить для подальшого 

використання або друку. 

3. Оформіть звіт з виконання практичної роботи, де зазначте всі виконані кроки, 

зроблені налаштування та отримані результати. 

Примітка: Не забувайте, що для ефективної роботи з ArcGIS важливо постійно 

практикуватися та вивчати додаткові інструменти для роботи з просторовими даними, 

щоб досягти максимальної точності та ефективності при аналізі геоінформації. 

 

Практична робота № 2 

Обробка растрового зображення в ArcGIS 

Мета: Ознайомитись з основними методами обробки растрових зображень в ArcGIS, 

навчитися виконувати базові операції з растровими даними, такими як корекція, аналіз і 

візуалізація. 

Завдання: 

1. Ознайомитися з процесом завантаження растрових зображень в ArcGIS. 

2. Вивчити основні інструменти обробки растрових зображень, зокрема корекцію 

зображень, виконання просторових операцій та аналізу. 



3. Навчитися виконувати візуалізацію оброблених даних на карті. 

Теоретичні положення: Растрові зображення в ГІС є одними з найбільш поширених 

типів даних, які використовуються для представлення різноманітних географічних і 

просторових явищ, таких як знімки супутників, аерофотозйомки, температурні карти 

тощо. Кожен піксель в растровому зображенні містить значення певного параметра 

(наприклад, висоти, температури, концентрації елементу), яке може бути використане для 

подальшого просторового аналізу. Обробка растрових зображень включає такі операції, як 

корекція кольору, змінення роздільної здатності, обчислення різних показників, виділення 

зон тощо. 

Порядок виконання: 

1. Завантаження растрових зображень: 

o Для початку відкрийте ArcGIS і створіть новий проект. 

o Завантажте растрове зображення в програму через меню "Catalog". Для 

цього знайдіть необхідний файл з растровим зображенням (наприклад, 

зображення з супутникових знімків або аерофото) і перетягніть його на 

карту. 

o Переконайтесь, що зображення коректно завантажене, та перевірте його 

проекцію і географічні координати. 

2. Визначення властивостей растрового зображення: 

o Клацніть правою кнопкою миші на зображенні в панелі "Table of Contents" і 

виберіть "Properties". 

o У вікні "Properties" перегляньте інформацію про растрове зображення, таку 

як роздільна здатність (розмір пікселів), проекція, мінімальні та максимальні 

значення пікселів. 

o Переконайтесь, що зображення відповідає вашому проєкту і має правильні 

географічні координати. 

3. Обробка растрового зображення: 

o Використовуйте інструмент "Raster Calculator" для виконання базових 

операцій з растровими зображеннями. Наприклад, ви можете виконати 

математичні операції між кількома растровими шарами (скласти, відняти 

або перемножити зображення). 

o Для цього перейдіть до меню "Spatial Analyst" -> "Map Algebra" -> "Raster 

Calculator", виберіть необхідні растрові шари і введіть математичну 

формулу для їх обробки. 

4. Корекція растрового зображення: 

o Якщо зображення потребує корекції (наприклад, корекція кольору чи 

яскравості), використовуйте інструменти зменшення контрасту або корекції 

кольору. Це можна зробити через меню "Raster" -> "Spatial Analyst" -> 

"Reclassify" або інші інструменти для корекції зображень. 

o Виберіть відповідний метод корекції, залежно від типу зображення і 

завдань. 

5. Виконання просторових операцій: 

o Ви можете застосовувати різні просторові операції для аналізу растрових 

зображень, наприклад, операції зонування (перетворення зображень у певні 

зони на основі значень пікселів), обчислення різниць між зображеннями та 

інше. 

o Для виконання операцій перейдіть до "Spatial Analyst" -> "Reclassify", "Map 

Algebra" або інших інструментів для виконання просторових операцій. 

6. Візуалізація результатів: 



o Після обробки растрового зображення ви можете змінити його стилізацію 

для кращої візуалізації. Використовуйте функцію зміни кольору через 

"Symbology" в меню властивостей шару. 

o Виберіть тип візуалізації (наприклад, градація кольору для зображень 

температури або висоти), налаштуйте кольорову палітру і відобразіть 

результати на карті. 

7. Аналіз результатів: 

o Після обробки растрового зображення проведіть аналіз отриманих 

результатів. Зробіть висновки про те, як обробка змінює візуалізацію та які 

зміни відбулись у даних після виконання операцій. 

8. Експорт обробленого зображення: 

o Завершивши обробку та аналіз, збережіть результат. Для цього перейдіть до 

меню "File" -> "Export Map" або "Export Raster", виберіть формат файлу 

(наприклад, TIFF, JPEG) і збережіть зображення. 

Оформлення результатів роботи: 

1. Збережіть результати обробки в окремий файл, щоб мати можливість поділитися 

або представити їх. 

2. Оформіть звіт, включаючи скріншоти інтерфейсу, опис виконаних операцій та 

отриманих результатів. 

3. Визначте, яку роль відіграє оброблене зображення в контексті вашого дослідження 

або проекту. 

Примітка: Для більш ефективної обробки растрових зображень рекомендується 

ознайомитись з додатковими можливостями програмних інструментів ArcGIS, що 

дозволяють застосовувати складніші аналізи та візуалізації. 

 

Практична робота № 3 

Трасування штатними та зовнішніми програмами растрового зображення в ArcGIS 

Мета: Ознайомитись з методами трасування растрових зображень в ArcGIS за допомогою 

стандартних інструментів програмного забезпечення та зовнішніх програм. Навчитися 

виконувати трасування для аналізу геопросторових даних. 

Завдання: 

1. Ознайомитися з методами трасування растрових зображень в ArcGIS. 

2. Виконати трасування з використанням штатних інструментів ArcGIS. 

3. Виконати трасування за допомогою зовнішніх програм, таких як FME або іншого 

програмного забезпечення. 

4. Провести аналіз результатів трасування. 

Теоретичні положення: Трасування — це процес визначення геометричних ліній або 

контурів, що з’єднують пікселі растрового зображення з однаковими або схожими 

значеннями (наприклад, висоти, температури, концентрації елементів). Цей процес є 

важливим для виділення певних зон або елементів в межах великої території, що 

зображена на растровому зображенні. Трасування може застосовуватись для виділення 

кордонів, визначення важливих ліній або для подальшого геопросторового аналізу. 



Порядок виконання: 

1. Завантаження растрового зображення: 

o Відкрийте ArcGIS і створіть новий проект. 

o Завантажте растрове зображення за допомогою меню "Catalog". Для цього 

знайдіть відповідне растрове зображення, яке ви будете використовувати 

для трасування (наприклад, супутникове зображення чи аерофото), і 

перетягніть його на карту. 

o Переконайтесь, що зображення має правильну проекцію та координати. 

2. Трасування з використанням стандартних інструментів ArcGIS: 

o Для початку скористайтесь інструментом "Raster to Polygon", щоб 

перетворити растрові дані в векторний формат, зберігши контури. Це 

дозволить працювати з окремими зонами та об’єктами. 

o Для цього відкрийте меню "Conversion Tools" -> "From Raster" -> "Raster to 

Polygon". Виберіть растрове зображення та налаштуйте параметри для 

конвертації. 

o Після перетворення растрового зображення в полигональний формат, можна 

буде виконати трасування ліній, що з’єднують однакові значення в межах 

зображення. 

3. Трасування контурів з використанням "Contour" в ArcGIS: 

o Використовуйте інструмент "Contour" для трасування контурів на основі 

значень пікселів растрового зображення. 

o Перейдіть до меню "Spatial Analyst" -> "Surface" -> "Contour" і налаштуйте 

параметри для генерації контурів. Вкажіть інтервал між контурами та інші 

необхідні параметри. 

o Результатом буде набір ліній, що з’єднують пікселі з однаковими 

значеннями, наприклад, для висот або інших параметрів. 

4. Виконання трасування з використанням зовнішніх програм (наприклад, 

FME): 

o Для більш складних трасувальних задач можна використовувати зовнішні 

програми, такі як FME (Feature Manipulation Engine), що надають додаткові 

інструменти для роботи з геопросторовими даними. 

o Завантажте відповідне растрове зображення у FME та використовуйте 

інструменти трасування, щоб виділити необхідні контури або лінії на основі 

значень пікселів. 

o Програма FME дозволяє створювати більш точні та складні моделі 

трасування, включаючи інтеграцію з іншими даними і форматами. 

5. Аналіз результатів трасування: 

o Після виконання трасування оцініть отримані контури та лінії. Перевірте, чи 

коректно відображаються контури на зображенні та чи правильно вони 

відповідають параметрам вашого дослідження. 

o Проведіть аналіз отриманих результатів, визначивши, чи зберігається 

необхідна точність та деталі при трасуванні контурів, а також чи правильно 

відображені географічні особливості. 

6. Візуалізація результатів трасування: 

o Після виконання трасування результат можна візуалізувати на карті. 

Налаштуйте стиль візуалізації для ліній, щоб чітко відобразити контури або 

траси на карті. 

o Використовуйте відповідні кольори та товщину ліній для візуалізації 

результатів трасування. 

7. Експорт результатів: 



o Після завершення обробки трасування збережіть результати роботи у 

відповідному форматі, щоб мати змогу використовувати їх для подальших 

аналізів або для представлення результатів. 

o Для цього перейдіть до "File" -> "Export" і виберіть потрібний формат для 

збереження даних. 

Оформлення результатів роботи: 

1. Створіть звіт, що містить скріншоти інтерфейсу програми, опис виконаних 

операцій та отриманих результатів. 

2. Включіть аналіз результатів трасування та пояснення щодо вибору інструментів 

для обробки даних. 

3. Визначте можливі варіанти застосування трасування для подальших досліджень та 

проектів. 

Примітка: Для більш точного трасування рекомендується ознайомитись з додатковими 

інструментами та програмами, що можуть бути корисними для обробки різноманітних 

растрових зображень і геопросторових даних. 

 

Практична робота № 4 

Візуалізація та експорт отриманих даних в ArcGIS 

Мета: Ознайомитись з методами візуалізації та експортом геопросторових даних в 

ArcGIS. Навчитися налаштовувати стилі візуалізації даних та експортувати результати 

роботи в різні формати для подальшого використання або друку. 

Завдання: 

1. Ознайомитись з основними методами візуалізації даних в ArcGIS. 

2. Налаштувати стилі візуалізації для різних типів даних (точки, лінії, полігони). 

3. Виконати експорт карт та результатів аналізів у різні формати для подальшого 

використання. 

Теоретичні положення: Візуалізація в географічних інформаційних системах (ГІС) — це 

процес представлення просторових даних у вигляді карт або інших графічних об’єктів, що 

дозволяє зрозуміти просторові взаємозв’язки та аналізувати різноманітні аспекти 

географічної інформації. Візуалізація даних в ArcGIS включає налаштування стилів для 

різних типів даних, таких як точки, лінії та полігони, а також використання різних 

кольорів, розмірів і символів для вираження інформації. 

Експорт даних дозволяє зберігати результати роботи в різних форматах для подальшої 

обробки, публікації чи друку. В ArcGIS можна експортувати карти, шари, таблиці та інші 

геопросторові дані в такі формати, як PDF, JPEG, TIFF, SHP, а також в інші формати, які 

підтримуються іншими програмами та системами. 

Порядок виконання: 

1. Налаштування стилів візуалізації: 

o Відкрийте ArcGIS і завантажте дані, які ви хочете візуалізувати (це можуть 

бути точки, лінії або полігони, залежно від вашого завдання). 



o Для налаштування стилю правою кнопкою миші клікніть на шар даних в 

панелі "Table of Contents" і виберіть "Properties". 

o У вікні "Layer Properties" перейдіть на вкладку "Symbology". Тут ви можете 

вибрати тип візуалізації для вашого шару: 

▪ Для точок: оберіть "Categories" та налаштуйте кольори для різних 

категорій. 

▪ Для ліній: оберіть "Quantities" або "Unique Values" для візуалізації за 

значеннями або категоріями. 

▪ Для полігонів: використовуйте "Graduated Colors" для візуалізації за 

кількісними значеннями або "Unique Values" для категоріальних 

даних. 

o Настройте кольори, розміри, форму символів та інші параметри, щоб чітко 

відобразити важливі аспекти ваших даних. 

2. Візуалізація результатів аналізу: 

o Після того, як ви налаштували стиль для основних даних, приступайте до 

візуалізації результатів аналізу. Це може бути результат просторового 

аналізу, створення буферів, трасування або інших типів аналізу. 

o Використовуйте інструменти візуалізації ArcGIS для підсвічування 

важливих елементів, наприклад, за допомогою різних кольорів або розмірів 

для виділення результатів геопросторових операцій. 

o Також можна використовувати інструмент "Layer Transparency", щоб 

зробити певні шари напівпрозорими для кращого перегляду під ними інших 

даних. 

3. Налаштування карти для друку: 

o Коли карта готова, підготуйте її до друку. Перейдіть на вкладку "Layout 

View" для створення макету карти. 

o Налаштуйте розмір аркуша, поля, заголовки та легенди. Можна додавати 

інші елементи, такі як масштаб, північний напрямок, підписи. 

o Для налаштування вигляду карти виберіть "Insert" -> "Legend", "North 

Arrow" або інші елементи, які ви хочете включити. 

4. Експорт результатів в інші формати: 

o Після того, як ви налаштували візуалізацію карти, можна експортувати її в 

різні формати. 

o Для експорту карти перейдіть до "File" -> "Export Map". 

o Виберіть потрібний формат для збереження: 

▪ PDF: для друку або подальшого поширення. 

▪ JPEG, TIFF, PNG: для збереження карти у вигляді зображення. 

▪ Shapefile (SHP): для експорту даних, щоб їх можна було 

використовувати в інших ГІС-системах. 

▪ KML: для експорту даних у формат, який можна переглядати в 

Google Earth. 

o Налаштуйте параметри експорту, такі як роздільна здатність (для 

зображень) та інші параметри, які можуть вплинути на якість результату. 

5. Збереження результатів в геопросторовому форматі: 

o Для збереження змін, що були внесені в шари даних (наприклад, після 

аналізу або трасування), використовуйте інструмент "Save As Layer File". Це 

дозволить зберегти всі налаштування і стратегії візуалізації для подальшої 

роботи. 

o Також можна створити нові шари, якщо ви додали нові елементи в існуючі 

дані або після виконання операцій, таких як буферизація або створення меж. 

6. Документування та підготовка звіту: 



o Після виконання візуалізації та експорту результатів оформіть звіт, який 

включатиме: 

▪ Скриншоти карти до і після налаштування візуалізації. 

▪ Опис налаштувань стилів і візуалізації. 

▪ Аналіз результатів та їх застосування для подальших досліджень або 

проектів. 

Примітка: 

Експорт карт та даних дозволяє інтегрувати результати роботи в інші програмні продукти 

або публікувати їх у вигляді карт для веб-ресурсів чи звітів. Використовуйте правильні 

формати для конкретних завдань, щоб забезпечити найкращу якість результатів. 

 

Практична робота № 6 

Літологічна колонка 

Мета: Навчитися створювати літологічну колонку на основі каротажних діаграм для 

вивчення будови геологічних прошарків. 

Завдання: 

1. Ознайомитися з поняттям літологічної колонки та її значенням в геології. 

2. Створити літологічну колонку, використовуючи дані каротажних діаграм. 

3. Зробити інтерпретацію отриманих результатів і побудувати профіль геологічного 

розрізу. 

Теоретичні положення: Літологічна колонка — це вертикальна схема, що відображає 

послідовність геологічних порід, які були виявлені під час буріння свердловини або 

каротажу. У колонці зазвичай показують різні типи порід, їхній склад, товщину та інші 

характеристики. Вона є важливим інструментом для аналізу геологічної будови ділянки, 

використовується для визначення потужності покладів, складу гірських порід, а також для 

прогнозування нафти, газу та інших корисних копалин. 

Літологічні колонки можуть включати: 

• Породу (пісок, глина, вапняк тощо). 

• Товщину шарів. 

• Ступінь насиченості водою або іншими рідинами. 

• Типи прошарків (кожна літологічна одиниця може бути представлена різними 

кольорами та текстурами). 

Порядок виконання: 

1. Ознайомлення з каротажними даними: 

o Открийте програму для роботи з каротажними діаграмами (наприклад, 

«Каротаж софт», «Petrel» або іншу програму, яка використовується для 

обробки даних каротажу). 

o Завантажте дані каротажних діаграм для обраної свердловини (або кількох 

свердловин, якщо є). 



o Ознайомтеся з типами порід, які зустрічаються в даних. Зазвичай, це будуть 

показники таких властивостей, як опірність, сейсмічні характеристики, 

щільність та інші. 

2. Визначення основних літологічних одиниць: 

o Перегляньте каротажні діаграми, щоб визначити зміни в складі порід на 

різних глибинах. 

o Розподіліть породи на окремі літологічні одиниці за допомогою інтервалів 

глибин. 

o Для кожної одиниці визначте склад (пісок, глина, вапняк тощо) та інші 

характеристики. 

3. Створення літологічної колонки: 

o Використовуйте програму для побудови графічної літологічної колонки. 

Виберіть відповідний інструмент для візуалізації даних. 

o Створіть вертикальний розріз, де кожен шар буде відповідати певній 

літологічній одиниці. Відобразіть зміни складу порід на різних глибинах. 

o Вказуйте товщину кожного шару, а також інші важливі параметри, такі як 

щільність або водонасиченість. 

o Використовуйте різні кольори та маркування для кращої наочності. 

4. Інтерпретація результатів: 

o Аналізуйте літологічну колонку, щоб зрозуміти геологічну будову даної 

ділянки. 

o Зробіть висновки про геологічну історію області, можливо, виділяючи 

важливі події, як, наприклад, зміни в умовах осадконакопичення. 

o Визначте, які породи можуть бути потенційно корисними для видобутку 

корисних копалин або водних ресурсів. 

5. Оформлення роботи: 

o Підготуйте звіт, в якому: 

▪ Охарактеризуйте кожну літологічну одиницю. 

▪ Додайте малюнки літологічної колонки, вказуючи глибини та 

відповідні породи. 

▪ Опишіть геологічну історію та особливості геологічної будови на 

основі вашої інтерпретації. 

Примітка: 

Літологічна колонка є потужним інструментом для вивчення геологічної структури та 

визначення потенціалу території для видобутку корисних копалин. Важливо ретельно 

аналізувати отримані дані і коректно відображати їх у графічному вигляді для подальшої 

інтерпретації. 

 

Практична робота № 7 

Цифрування каротажних діаграм 

Мета: Ознайомитися з процесом цифрування каротажних діаграм, що дозволяє 

перетворити графічні дані на числові для подальшого аналізу та обробки в програмних 

середовищах. 

Завдання: 

1. Оволодіти методикою цифрування каротажних діаграм. 

2. Створити цифрові версії каротажних графіків для аналізу. 



3. Використовувати отримані дані для подальших інтерпретацій і моделювань. 

Теоретичні положення: Цифрування каротажних діаграм є процесом перетворення 

даних, що відображені на графічних каротажних діаграмах, у цифрову форму. Це дозволяє 

аналізувати ці дані за допомогою спеціалізованого програмного забезпечення та 

проводити більш точні розрахунки. Цифрування дозволяє виявити закономірності, зв’язки 

між параметрами та зробити прогноз щодо геологічних характеристик. 

Для цифрування використовуються спеціальні програми, які дозволяють вручну або 

автоматично визначати значення каротажних кривих в точках перетину з вертикальними 

лініями шкали. Цей процес може бути виконаний вручну або автоматизовано, залежно від 

складності та доступного програмного забезпечення. 

Порядок виконання: 

1. Ознайомлення з каротажною діаграмою: 

o Отримайте каротажну діаграму для обраної свердловини. 

o Ознайомтесь з різними кривими на діаграмі (опірність, щільність, 

пористість, вологість тощо) і шкалами, які вказують на глибину або інші 

параметри. 

2. Вибір програмного забезпечення для цифрування: 

o Завантажте програмне забезпечення для цифрування (наприклад, «Каротаж 

софт», «Petrel», «WellCAD» тощо). 

o Увійдіть до програми та імпортуйте каротажні діаграми (можливо у 

форматах .tif, .jpg або інших, залежно від програми). 

3. Цифрування каротажних кривих: 

o Виберіть каротажну криву, яку необхідно оцифрувати. За допомогою 

інструменту для цифрування вибирайте точки перетину з вертикальними 

лініями шкали, записуючи числові значення для кожної точки. 

o Кожен перетин на кривій відповідає певному значенню параметра 

(наприклад, опірності, щільності), яке потрібно зафіксувати. 

o Визначте відповідну глибину для кожного значення, щоб зберегти точність і 

коректність даних. 

4. Автоматизація цифрування (за наявності): 

o Якщо програма підтримує автоматичне цифрування, налаштуйте її для 

розпізнавання каротажних кривих. 

o Програма може виконати автоматичне визначення значень у кожній точці 

по кривій, що значно прискорює процес. 

5. Перевірка точності оцифрованих даних: 

o Після завершення цифрування перевірте отримані значення на предмет 

відповідності діаграмі та шкалі. 

o Переконайтесь, що всі дані коректно оцифровані, і в разі потреби здійсніть 

корекцію вручну. 

6. Експорт цифрованих даних: 

o Збережіть цифровані дані у відповідному форматі (наприклад, .csv, .xls або 

інший), який підтримується для подальшої обробки та аналізу. 

o Важливо, щоб дані були коректно експортовані для подальших 

геоінформаційних чи геофізичних розрахунків. 

7. Оформлення результатів: 

o Підготуйте звіт, в якому: 

▪ Охарактеризуйте методи цифрування, які ви застосовували. 

▪ Наведіть приклади оцифрованих кривих з каротажних діаграм. 



▪ Описуйте результат, що вказує на точність отриманих даних та 

подальші кроки для їх використання. 

Примітка: 

Цифрування каротажних діаграм є важливим етапом у геологічних дослідженнях, 

оскільки воно дозволяє точно та швидко отримувати числові дані з графічних джерел. 

Процес вимагає уважності та точності, щоб уникнути помилок при інтерпретації 

результатів. 

 

Практична робота № 8 

Імпорт даних та контроль їх якості 

Мета: Ознайомитись з процесом імпорту даних з різних джерел у програмне забезпечення 

для геофізичних та геологічних досліджень, а також навчитися здійснювати контроль 

якості імпортованих даних. 

Завдання: 

1. Імпортувати дані з різних джерел у програмне забезпечення. 

2. Провести контроль якості імпортованих даних, виявити і виправити можливі 

помилки. 

3. Підготувати дані для подальшої обробки та аналізу. 

Теоретичні положення: Імпорт даних у геоінформаційні системи (ГІС) та інші 

спеціалізовані програми є важливим етапом для подальшого їх аналізу та візуалізації. 

Правильний імпорт забезпечує коректне використання даних у проекті, знижуючи 

ймовірність помилок при їх подальшій обробці. 

Існують різні типи даних, які можуть бути імпортовані в програми, включаючи: 

• Растрові дані (зображення, карти, фотографії). 

• Векторні дані (точки, лінії, полигони). 

• Табличні дані (відомості, зібрані з польових досліджень, лабораторних аналізів). 

Важливим аспектом є контроль якості імпортованих даних, який передбачає перевірку 

правильності формату, точності та повноти даних. 

Порядок виконання: 

1. Підготовка джерела даних: 

o Ознайомтесь із джерелом даних, що буде імпортовано (наприклад, таблиці з 

польових спостережень, дані каротажу або GPS-координати). 

o Перевірте формат даних (наприклад, .csv, .shp, .tif, .txt, .xyz). 

2. Імпорт даних у програмне забезпечення: 

o Відкрийте програму, в яку ви будете імпортувати дані (наприклад, ArcGIS, 

Petrel, Excel, або інші спеціалізовані програми). 

o Оберіть відповідну команду для імпорту даних (наприклад, в ArcGIS це 

може бути команда "Add Data" або "Import"). 

o Завантажте файл з даними, вказавши точний шлях до файлу або вибравши 

його через діалогове вікно. 



3. Перевірка якості імпортованих даних: 

o Контроль формату: Перевірте, чи правильно розпізнано формат даних. 

Наприклад, для векторних даних повинна коректно визначитись геометрія 

(точки, лінії, полігони), а для растрових — пікселі та їх відображення. 

o Перевірка коректності даних: Оцініть, чи всі дані коректно імпортувались, 

чи немає пропущених або пошкоджених значень (наприклад, якщо 

імпортується таблиця, переконайтесь, що всі поля містять коректні 

значення). 

o Перевірка точності географічних координат: Якщо ви працюєте з 

географічними даними (наприклад, GPS-координати), перевірте їх 

відповідність реальним об'єктам або місцевості на карті. 

o Контроль одиниць виміру: Перевірте, чи всі одиниці виміру (глибина, 

температура, щільність тощо) правильно імпортовані та не порушена їх 

логіка (наприклад, міліметри замість метрів). 

4. Обробка помилок імпорту: 

o Якщо виявлено помилки, використовуйте інструменти для виправлення або 

коригування даних: 

▪ Для табличних даних можна виправити значення вручну або через 

автоматичне коригування в програмі. 

▪ Для векторних і растрових даних можна застосувати методи для 

виправлення геометрії або перетворення координат. 

o За необхідності зверніться до джерела даних і переконайтесь, що вони не 

містять помилок ще на етапі збору. 

5. Перевірка на повноту даних: 

o Після імпорту перевірте, чи всі необхідні дані були включені. Якщо якихось 

даних не вистачає, зверніться до джерела інформації або здійсніть 

додатковий імпорт. 

o Підтвердження наявності всіх необхідних записів важливо для коректного 

аналізу даних. 

6. Експорт даних: 

o Після того як дані будуть успішно імпортовані та перевірені на коректність, 

збережіть їх у потрібному форматі для подальшої обробки або аналізу. 

o Використовуйте команду експорт даних, щоб зберегти їх у форматі, який 

буде зручний для подальшої роботи (наприклад, .csv, .xls, .shp). 

7. Документування результатів: 

o Зафіксуйте усі кроки імпорту даних у звіті, включаючи джерело даних, 

формат, тип імпорту, а також виявлені помилки і способи їх виправлення. 

o Оформіть звіт, зазначивши, чи вдалося успішно імпортувати і перевірити 

дані. 

Примітка: 

Імпорт даних і контроль їх якості є критично важливими етапами у роботі з географічною 

інформацією, оскільки від коректності цих процесів залежить точність подальших 

досліджень і прийнятих рішень. 

 

Практична робота № 9 

Редагування вхідних даних 



Мета: Ознайомитись із процесом редагування вхідних даних у геоінформаційних та 

геофізичних системах. Навчитися вносити зміни в дані для забезпечення їх точності та 

відповідності вимогам для подальшого аналізу. 

Завдання: 

1. Завантажити вхідні дані в програму. 

2. Виконати редагування вхідних даних відповідно до вимог завдання. 

3. Перевірити правильність внесених змін та підготувати дані до подальшої обробки. 

Теоретичні положення: Редагування вхідних даних є важливою складовою роботи з 

геоінформаційними системами (ГІС) та програмами для геофізичних досліджень. Часом 

на етапі збору даних можуть виникати помилки або неточності, які потребують 

виправлення перед початком їх аналізу. Редагування даних може включати зміну 

геометрії об'єктів, коригування значень у таблицях або виправлення даних про 

координати. 

Основні етапи редагування даних: 

• Коригування геометрії об'єктів (векторних даних), таких як точки, лінії або 

полігони. 

• Редагування атрибутів (зміна значень у таблицях). 

• Коригування координат для точок або об'єктів на карті. 

• Фільтрація та очищення даних, усунення дублюючих записів або аномальних 

значень. 

Порядок виконання: 

1. Завантаження вхідних даних: 

o Імпортуйте дані в програму, яку ви використовуєте для редагування 

(наприклад, ArcGIS, Petrel, QGIS тощо). 

o Ознайомтесь з вхідними даними (географічними або геофізичними), 

перевірте їх структуру та формат. 

2. Аналіз даних перед редагуванням: 

o Перед тим як вносити зміни, ретельно проаналізуйте дані, звертаючи увагу 

на можливі помилки (наприклад, неузгодженість геометрії об'єктів, 

некоректні атрибути або координати). 

o Використовуйте інструменти перевірки якості даних, якщо такі є в 

програмному забезпеченні. 

3. Редагування геометрії векторних даних: 

o У разі необхідності коригуйте координати точок, ліній чи полігонів. Це 

може бути необхідно, якщо точки на карті розташовані неправильно через 

помилки при імпорті або отриманні даних. 

o За допомогою інструментів редагування переміщуйте, додавати або 

видаляти об'єкти на карті. 

o Перевірте, чи не виникли проблеми з геометрією після редагування, 

наприклад, самоперетини чи відкриті лінії. 

4. Редагування атрибутів даних: 

o Відкрийте таблицю атрибутів, яка супроводжує вхідні дані, і перевірте 

наявність помилок у значеннях (наприклад, неправильні одиниці виміру, 

неіснуючі категорії). 



o Виправте помилки, змінивши значення безпосередньо в таблиці, 

використовуючи інструменти редагування. 

o Якщо необхідно, застосуйте функцію пошуку та заміни для швидкого 

коригування значень. 

5. Коригування координат: 

o Якщо дані включають географічні координати, перевірте їх правильність. 

o Якщо необхідно, використовуйте інструменти для перенесення або 

коригування координат точок, щоб вони відповідали реальній місцевості. 

o Можна також застосовувати функції для трансформації координат у різні 

системи координат. 

6. Виправлення помилок та аномалій: 

o Виявлення та виправлення аномальних або дубльованих записів. В разі 

необхідності видаляти або коригувати записи, які не відповідають 

стандартам якості даних. 

o Використовуйте функції перевірки на неповні або помилкові записи для 

забезпечення чистоти даних. 

7. Збереження змін та перевірка результатів: 

o Після редагування збережіть зміни у відповідному форматі. 

o Перевірте результати редагування: переконайтесь, що всі дані були внесені 

коректно та що не виникло нових помилок. 

o Зробіть резервну копію даних перед початком подальшої обробки. 

8. Документування результатів: 

o Оформіть звіт про виконану роботу, зазначивши, які саме редагування були 

виконані, а також виявлені помилки та способи їх виправлення. 

o У звіті також зазначте, які інструменти та функції ви використовували для 

редагування даних. 

Примітка: 

Редагування даних — це критично важливий етап, адже навіть невеликі помилки можуть 

значно вплинути на точність та достовірність кінцевих результатів досліджень. Тому 

важливо проводити редагування даних обережно та ретельно перевіряти їх після кожної 

зміни. 

 

Практична робота № 10 

Візуалізація каротажних діаграм та кореляція свердловин 

Мета: Ознайомитись з методами візуалізації каротажних діаграм, а також навчитись 

виконувати кореляцію свердловин для аналізу геофізичних даних, отриманих за 

допомогою каротажу. 

Завдання: 

1. Імпортувати каротажні діаграми в програму. 

2. Виконати візуалізацію каротажних діаграм для наочного відображення 

геофізичних властивостей порід. 

3. Виконати кореляцію між свердловинами для визначення просторових 

взаємозв'язків між даними. 

Теоретичні положення: Каротажні діаграми — це графічне відображення геофізичних 

параметрів, отриманих під час проведення каротажу свердловини. Вони 



використовуються для аналізу фізичних та хімічних властивостей порід, таких як 

електричний опір, пористість, вологість тощо. Каротаж допомагає визначити склад порід, 

глибину залягання корисних копалин, а також вивчити їх структуру. 

Кореляція свердловин — це метод, який дозволяє зіставити каротажні діаграми з кількох 

свердловин, щоб встановити зв'язки між геологічними характеристиками в різних точках 

місцевості. Це допомагає краще розуміти просторову поширеність і закономірності порід, 

а також оцінити тенденції змін фізичних властивостей вглиб земної кори. 

Порядок виконання: 

1. Імпорт каротажних діаграм: 

o Завантажте дані з каротажу в програму, що використовується для обробки 

геофізичних даних (наприклад, Petrel, OPIUM або інші ПЗ для каротажу). 

o Переконайтесь, що дані імпортуються в правильному форматі (наприклад, 

LAS або ASCII) і всі необхідні параметри включено. 

2. Аналіз каротажних діаграм: 

o Вивчіть графіки на діаграмах для кожної свердловини, визначте основні 

параметри, що потребують візуалізації (наприклад, пористість, насиченість 

водою, електричний опір). 

o Визначте, які каротажні параметри будуть корисні для подальшого аналізу 

та кореляції. 

3. Візуалізація каротажних діаграм: 

o За допомогою інструментів ПЗ для геофізичних досліджень створіть 

візуалізацію даних на каротажних діаграмах. Для цього можна 

використовувати різні типи графіків: лінійні, точкові, гістограми або 

профілі. 

o Налаштуйте відображення даних таким чином, щоб чітко було видно зміни 

геофізичних характеристик на різних глибинах. Можна вибрати кольорове 

відображення для кращої наочності. 

4. Кореляція свердловин: 

o Для виконання кореляції свердловин необхідно зіставити каротажні 

діаграми за допомогою загальних маркерів, таких як рівні базових порід, 

горизонти, а також схожі або однакові геофізичні характеристики. 

o Використовуйте програмне забезпечення для створення кореляційних 

графіків, які дозволяють візуалізувати зміни в одних і тих же порід на різних 

свердловинах. 

o Застосуйте методи порівняння діаграм, щоб точно визначити глибину 

розташування горизонтів або аномалій, а також співвідношення між різними 

параметрами для кожної свердловини. 

5. Порівняння даних між свердловинами: 

o Оцініть взаємозв'язок між каротажними параметрами, що мають місце в 

одних і тих же горизонтах на різних свердловинах. 

o Розгляньте різні підходи до кореляції (наприклад, графічний, математичний 

або логічний методи) для точної локалізації геофізичних аномалій або 

корисних копалин. 

6. Виведення результатів: 

o Після виконання кореляції свердловин і візуалізації каротажних діаграм, 

підготуйте результат для подальшого аналізу. 

o Підготуйте звіт, в якому докладно описано процес виконання роботи, 

використані методи, інструменти, а також результати візуалізації та 

кореляції свердловин. 



7. Документування та оформлення: 

o Оформіть звіт за підсумками виконаної роботи. Звіт має включати 

пояснення до кожного етапу візуалізації та кореляції. 

o Використовуйте графіки та діаграми для ілюстрації результатів роботи. 

o У підсумку звіту вкажіть висновки щодо точності кореляції, можливих 

геологічних інтерпретацій та рекомендацій для подальшого дослідження. 

Примітка: 

Кореляція свердловин дозволяє створити більш точну модель розповсюдження 

геофізичних параметрів на більшій території. Візуалізація каротажних діаграм дозволяє 

ефективно вивчати зміни фізичних властивостей порід і точно корелювати їх із даними з 

інших свердловин для кращого розуміння геологічної структури. 

 

Практична робота № 11 

Моделювання розломів 

Мета: Ознайомитись з методами моделювання геологічних розломів у програмному 

забезпеченні для геофізичних досліджень, таких як Schlumberger Petrel чи інші аналоги. 

Навчитись створювати точні моделі розломів, які відображають геологічну структуру 

території та можливі зсуви. 

Завдання: 

1. Імпортувати дані, необхідні для моделювання розломів. 

2. Створити модель геологічних розломів в обраному програмному забезпеченні. 

3. Виконати аналіз впливу розломів на геологічну структуру і наявність корисних 

копалин. 

Теоретичні положення: Розломи є одними з основних структурних елементів земної 

кори, що виникають через тектонічні сили, які спричиняють зміщення земних пластів. 

Моделювання розломів дозволяє вивчати їх вплив на розподіл порід, корисних копалин, а 

також на розташування підземних вод та інших геофізичних характеристик. 

Моделювання розломів часто використовується для прогнозування руху розломних 

структур, а також для розробки ефективних методів добування корисних копалин або 

управління підземними водними ресурсами. 

Порядок виконання: 

1. Імпорт даних для моделювання: 

o Завантажте геологічні дані, необхідні для моделювання розломів, до 

програмного забезпечення (наприклад, Schlumberger Petrel). 

o Дані повинні містити інформацію про структуру порід, глибину розломів, а 

також інші геофізичні та геологічні характеристики. 

o Переконайтесь, що всі дані мають правильний формат для імпорту і не 

містять помилок. 

2. Створення моделі розломів: 

o Використовуйте інструменти програмного забезпечення для моделювання 

геологічних розломів. Це може включати побудову 3D моделей, в яких 



розломи будуть представлені як геометричні структури, що мають певні 

характеристики (напрямок, схил, глибина і т.д.). 

o Визначте типи розломів (наприклад, нормальні, зворотні, зрізні), що 

найбільш точно відповідають даним про тектонічні процеси на вашій 

території. 

o Візуалізуйте створену модель у вигляді 3D карт або 3D моделей, що дасть 

можливість аналізувати розломи в різних просторових напрямах. 

3. Аналіз параметрів розломів: 

o Проаналізуйте, як розломи змінюють геологічну структуру території. Це 

може включати зміщення пластів, утворення нових блоків, або зміни в 

глибині залягання корисних копалин. 

o Оцінити, як розломи можуть впливати на такі характеристики, як зберігання 

водних ресурсів, а також на геотермальні умови в межах розлому. 

4. Визначення геофізичних параметрів на розломах: 

o Після моделювання розломів можна також врахувати зміни у геофізичних 

параметрах, таких як пористість, насиченість водою, електричний опір і 

інші, які можуть бути корисними для подальших досліджень. 

o Врахуйте, як геофізичні властивості можуть змінюватися на межах розломів 

або поблизу них. 

5. Оцінка впливу розломів на гірничі роботи та добування корисних копалин: 

o Якщо мета роботи полягає в аналізі родовищ корисних копалин, здійсніть 

моделювання впливу розломів на поклади корисних копалин (наприклад, на 

газові чи нафтові родовища). 

o Розгляньте, як ці розломи можуть змінювати доступність ресурсів для 

подальшої розробки. 

6. Оформлення результатів: 

o Створіть наочні графіки, карти або 3D моделі, що чітко відображають 

створену модель розломів та їх характеристики. 

o Підготуйте детальний звіт, що включає опис використовуваних методів, 

отриманих результатів, а також рекомендації для подальшого аналізу або 

розробки родовищ. 

Примітка: 

Моделювання розломів є важливим інструментом для розуміння геологічної будови 

території, що допомагає в плануванні гірничих робіт, розробці корисних копалин, а також 

для прогнозування природних катастроф, таких як землетруси. Важливо використовувати 

сучасні програмні засоби для створення точних моделей, що базуються на реальних 

даних. 

 

Практична робота № 12 

Pillar Gridding 

Мета: Ознайомитись з методами побудови та застосування технології Pillar Gridding для 

створення детальних моделей геологічних структур на основі даних про гірничі родовища 

або інші природні утворення. 

Завдання: 

1. Виконати імпорт геологічних даних до програмного забезпечення (наприклад, 

Schlumberger Petrel). 



2. Побудувати модель Pillar Gridding, використовуючи надані дані. 

3. Проаналізувати результат створеної моделі та її застосування для подальшої 

геологічної оцінки. 

Теоретичні положення: Pillar Gridding – це метод, що використовується для створення 

структурних моделей в геофізичних та геологічних дослідженнях, зокрема для 

моделювання покладів корисних копалин, підземних водних резервуарів та інших 

природних об'єктів. Метод полягає у побудові сітки «стовпців» (pillars), які відображають 

різні геологічні характеристики або параметри, наприклад, пористість, щільність, 

насичення тощо. Використовуючи цю сітку, можна отримати точні 3D моделі, що 

допомагають в аналізі розподілу ресурсів або прогнозуванні природних процесів. 

Порядок виконання: 

1. Імпорт даних для моделювання Pillar Gridding: 

o Завантажте геологічні дані, що включають інформацію про структуру та 

властивості порід на досліджуваній території. Дані повинні містити 

координати точок (свердловин, геофізичних вимірювань тощо) та відповідні 

параметри (щільність, пористість, вміст корисних копалин і т.д.). 

o Переконайтесь, що дані мають правильний формат для імпорту в програму, 

яку ви використовуєте (наприклад, Schlumberger Petrel або інші геофізичні 

програми). 

2. Створення сітки Pillar Gridding: 

o Виберіть необхідний розмір та кількість стовпців для створення сітки Pillar 

Gridding. Стовпці повинні відповідати геологічним умовам вашої території і 

бути достатньо дрібними для точного відображення змін у геологічних 

параметрах. 

o У програмному забезпеченні використовуйте інструменти для побудови 

стовпців, розташувавши їх відповідно до координат точок з даними про 

геологічну структуру. 

3. Налаштування властивостей сітки: 

o Кожен стовпець в сітці має бути наділений певними властивостями: це 

можуть бути значення щільності, пористості, глибини або інших важливих 

параметрів. 

o Визначте межі стовпців та їх розмір відповідно до просторових та 

геологічних характеристик вашої території. 

o Встановіть необхідні параметри для моделювання (наприклад, для 

геофізичних або геохімічних моделей). 

4. Аналіз отриманої сітки: 

o Після побудови сітки здійсніть аналіз результатів. Вивчіть, як різні 

геологічні параметри змінюються по території. Зверніть увагу на наявність 

аномалій або змін в геологічній структурі, які можуть бути важливими для 

подальших досліджень. 

o Для кращої візуалізації можна створити 3D моделі сітки Pillar Gridding, які 

дозволять краще зрозуміти просторові розподіли. 

5. Інтерпретація результатів: 

o На основі моделі Pillar Gridding проведіть інтерпретацію отриманих 

результатів. Це може включати оцінку родовищ корисних копалин, розподіл 

водних ресурсів або прогнозування природних процесів, таких як 

землетруси або рух підземних вод. 



o Моделювання за допомогою Pillar Gridding може бути використано для 

детальнішого аналізу потенційних зон видобутку або планування гірничих 

робіт. 

6. Оформлення результатів: 

o Підготуйте візуалізації отриманих моделей у вигляді 3D карт, графіків або 

інших діаграм, які будуть наочними та зручними для подальшої роботи. 

o У звіті детально опишіть використані методи, обґрунтуйте вибір параметрів 

та розмірів сітки, а також надайте рекомендації для подальших геологічних 

досліджень. 

Примітка: 

Метод Pillar Gridding використовується в геофізичних та гірничих дослідженнях для 

побудови точних моделей геологічних структур. Він дозволяє визначити просторові 

характеристики об'єктів, зокрема в процесі розвідки корисних копалин або водних 

ресурсів. Важливо проводити коректне налаштування сітки і використовувати точні дані 

для отримання достовірних результатів. 

 

Практична робота № 13 

Розбивка на зони та шари. Глибинне перетворення 

Мета: Ознайомитись з процесом розбиття геологічних даних на зони та шари, а також 

виконати глибинне перетворення даних для моделювання геологічних структур. 

Завдання: 

1. Виконати розбиття геологічних даних на зони та шари відповідно до даних про 

свердловини або геофізичних вимірювань. 

2. Використовувати методи глибинного перетворення для створення 3D моделей та 

аналізу геологічної структури. 

3. Оцінити отримані результати та інтерпретувати геологічні властивості на основі 

цих моделей. 

Теоретичні положення: Розбивка на зони та шари є важливим етапом при створенні 

геологічних моделей, оскільки дозволяє чітко визначити межі різних геологічних одиниць, 

таких як породи, шари, водоносні горизонти або поклади корисних копалин. Глибинне 

перетворення (depth conversion) є процесом переведення даних з часу (для сейсмічних 

вимірювань) у глибину для отримання точних 3D моделей, що дозволяють з точністю 

вивчати геологічні процеси та ресурси. 

Порядок виконання: 

1. Імпорт даних: 

o Завантажте дані про свердловини, сейсмічні вимірювання або інші 

геофізичні дані, що містять інформацію про глибину та інтервали 

вимірювань. 

o Перевірте, що дані правильно форматуйте для подальшого аналізу в 

програмному забезпеченні (наприклад, Schlumberger Petrel або ArcGIS). 

2. Розбивка на зони: 



o На основі геологічних даних розбийте досліджувану територію на зони. 

Кожна зона повинна відображати певний геологічний контекст, наприклад, 

шар піщаника, вапняку, глини або інші геологічні одиниці. 

o Визначте межі кожної зони та створіть відповідну сітку для розподілу 

даних. 

o Враховуйте зміни в геологічних характеристиках (таких як щільність, 

пористість, літологія) при визначенні меж зон. 

3. Створення шарів: 

o За допомогою геофізичних даних (наприклад, з даних про каротаж) створіть 

шари, що будуть представляти різні глибини або інтервали між точками 

вимірювань. 

o Визначте товщину кожного шару та його характеристики, такі як 

пористість, щільність, насичення водою чи іншими компонентами. 

o Для кожного шару використовуйте дані про фізичні властивості (щільність, 

пористість, насичення) для подальшої інтерпретації результатів. 

4. Глибинне перетворення: 

o Використовуйте методи глибинного перетворення, щоб перевести часові 

значення сейсмічних даних у глибину. Це дозволить створити точніші 

моделі геологічних структур. 

o Під час глибинного перетворення враховуйте швидкість поширення хвиль у 

різних шарах, щоб забезпечити точність моделювання. 

o Для коректного перетворення можна використовувати інтерполяційні 

методи для заповнення проміжних даних. 

5. Створення 3D моделей: 

o Використовуйте дані про зони, шари та перетворені глибинні дані для 

створення 3D моделей геологічної структури. 

o Візуалізуйте різні геологічні одиниці та їх взаємозв'язок на території, 

звертаючи увагу на зони з високою ймовірністю наявності покладів 

корисних копалин або водоносних горизонтів. 

6. Аналіз та інтерпретація результатів: 

o Після створення моделей проведьте аналіз геологічних властивостей кожної 

зони та шару. 

o Оцініть можливі перспективи видобутку корисних копалин, оцінку запасів 

води або іншого ресурсу в межах розбитих зон і шарів. 

o Порівняйте різні інтервали глибини для отримання інформації про зміни в 

складі геологічних утворень. 

7. Оформлення результатів: 

o Підготуйте звіт із результатами роботи. Включіть в нього 3D моделі, 

графіки та таблиці для кращого розуміння просторового розподілу 

геологічних параметрів. 

o У звіті повинні бути зазначені основні методи, які були використані для 

розбиття на зони та шари, а також проведено глибинне перетворення. 

o Оформіть підписи до моделей та інтерпретованих даних. 

Примітка: 

Розбивка на зони та шари є основним етапом в моделюванні геологічних утворень і 

допомагає створювати точні 3D моделі для подальших досліджень. Глибинне 

перетворення є критичним для точного моделювання глибоких геологічних структур, а 

також для розуміння взаємозв'язку між різними шарами та зонами на великих глибинах. 

 



Практична робота № 14 

Моделювання геометричних властивостей 

Мета: Ознайомитися з методами моделювання геометричних властивостей геологічних 

об'єктів, таких як форма, розмір і просторове розташування, а також їх вплив на 

інтерпретацію геологічних даних. 

Завдання: 

1. Виконати моделювання геометричних властивостей геологічних тіл за допомогою 

програмного забезпечення (наприклад, Schlumberger Petrel, ArcGIS). 

2. Оцінити геометричні характеристики геологічних утворень, такі як товщина, об'єм, 

просторове розташування, форма. 

3. Виконати інтерпретацію отриманих моделей для визначення розподілу корисних 

копалин, водоносних горизонтів чи інших геологічних утворень. 

Теоретичні положення: Геометричні властивості геологічних утворень включають в себе 

форми, розміри, товщину та об'єм різних геологічних тіл, таких як пласти, поклади, 

резервуари води чи нафти. Моделювання геометричних властивостей дозволяє створити 

більш точні просторові моделі геологічних структур, які можуть бути використані для 

прогнозування наявності корисних копалин, оптимізації розробки родовищ та управління 

водними ресурсами. 

Основні методи моделювання геометричних властивостей включають: 

• Моделювання форми геологічних тіл: використання геометричних примітивів 

(площини, куби, кола) для апроксимації природних утворень. 

• Моделювання розмірів і товщини: визначення точних меж геологічних тіл на 

основі даних з сейсмічних досліджень, каротажу або інших методів. 

• Оцінка об'єму: розрахунок об'ємів геологічних тіл для подальшого визначення 

потенційних ресурсів або обсягів води. 

Порядок виконання: 

1. Імпорт геологічних даних: 

o Завантажте дані про геологічні утворення, отримані з каротажу, сейсмічних 

досліджень або інтерпретаційних даних. 

o Перевірте правильність форматування даних для подальшого використання 

в програмному забезпеченні (наприклад, для імпорту в Schlumberger Petrel 

або ArcGIS). 

2. Моделювання форми геологічних тіл: 

o Створіть геометричні моделі для геологічних тіл. Використовуйте 

геометричні примітиви (площини, блоки, конуси), щоб відобразити форму 

геологічних утворень. 

o Програмне забезпечення може дозволяти автоматичне створення форм за 

даними свердловин або сейсмічних досліджень, що дозволяє швидко 

оцінити основні геометричні характеристики. 

3. Оцінка товщини і розміру геологічних тіл: 

o Визначте товщину геологічних утворень на основі даних про різні 

горизонти, отриманих із каротажу. 

o Моделюйте товщину шарів або покладів для більш точного визначення їх 

розмірів та обсягів. 



4. Моделювання просторового розташування: 

o Визначте координати та орієнтацію геологічних тіл у просторі, 

застосовуючи методи просторової інтерполяції. 

o Використовуйте дані з різних джерел (сейсмічні, каротажні тощо), щоб 

забезпечити точне моделювання просторового розташування геологічних 

тіл. 

5. Оцінка об'єму геологічних тіл: 

o Використовуйте програмне забезпечення для розрахунку об'ємів 

геологічних тіл на основі їх геометричних характеристик. 

o Розрахуйте об'єм кожного геологічного шару або покладу для подальшої 

оцінки ресурсів або водоносних горизонтів. 

6. Аналіз і корекція моделей: 

o Перевірте точність моделі, порівнявши її з наявними даними або 

результатами попередніх досліджень. 

o За необхідності коригуйте параметри геометричних моделей для досягнення 

більшої точності. 

7. Інтерпретація та оцінка результатів: 

o Проведіть аналіз отриманих геометричних моделей для визначення 

потенційних корисних копалин, водоносних горизонтів або інших 

природних ресурсів. 

o Оцініть можливості використання отриманих моделей для подальших 

досліджень або розробки родовищ. 

8. Оформлення результатів: 

o Підготуйте звіт, у якому буде наведена розгорнута інтерпретація отриманих 

геометричних моделей. 

o Включіть графіки, 3D моделі та таблиці для наочного зображення 

геометричних властивостей. 

o Оформіть підписи до графічних матеріалів, що допоможуть візуалізувати 

процес моделювання та отримані результати. 

Примітка: Моделювання геометричних властивостей є важливим етапом у геологічному 

дослідженні, оскільки точне моделювання форми, розміру та просторового розташування 

геологічних тіл дозволяє з високою точністю оцінити природні ресурси і прогнозувати 

майбутні зміни в геологічних структурах. 

 

Практична робота № 15 

Петрофезичне моделювання 

Мета: Ознайомитися з методами петрофізичного моделювання для визначення 

властивостей геологічних тіл, таких як пористість, проникність, насиченість флюїдами, і 

їх вплив на характеристики родовищ нафти, газу чи води. 

Завдання: 

1. Виконати петрофізичне моделювання геологічних утворень на основі даних 

каротажу та інших джерел інформації. 

2. Оцінити фізико-хімічні властивості порід, такі як пористість, проникність і 

насиченість флюїдами. 

3. Виконати інтерпретацію отриманих результатів для прогнозування потенціалу 

родовища і можливості його розробки. 



Теоретичні положення: Петрофізичне моделювання — це процес, що включає створення 

моделей фізичних властивостей гірських порід та їх флюїдних характеристик. Важливими 

характеристиками є: 

• Пористість (φ) — об'єм пор, що містяться в породі, який може бути заповнений 

флюїдами. 

• Проникність (k) — здатність породи пропускати флюїди через себе. 

• Насиченість флюїдами (S) — частка пор, заповнених флюїдами (нафта, вода, газ). 

Петрофізичне моделювання є важливим етапом при оцінці ефективності розробки 

родовищ вуглеводнів, водоносних горизонтів та інших природних ресурсів. 

Порядок виконання: 

1. Імпорт даних: 

o Завантажте дані каротажу, що містять інформацію про фізичні властивості 

порід (пористість, проникність, насиченість флюїдами). 

o Перевірте дані на коректність і сумісність з програмним забезпеченням для 

подальшого аналізу (наприклад, Schlumberger Petrel або аналогічне ПЗ). 

2. Вибір моделі петрофізичних властивостей: 

o Виберіть метод моделювання для оцінки пористості та проникності порід. 

Це може бути модель пористості по каротажним даним або через 

інтерполяцію. 

o Моделі можуть включати залежності між проникністю і пористістю, а також 

включати флюїдні характеристики для оцінки насиченості. 

3. Петрофізичне моделювання: 

o Використовуючи програми для геофізичних досліджень (Schlumberger 

Petrel, ArcGIS, або інше спеціалізоване ПЗ), виконайте петрофізичне 

моделювання. 

o Розрахуйте основні властивості: пористість, проникність, насиченість 

флюїдами для кожного з геологічних шарів або покладів. 

4. Аналіз результатів моделювання: 

o Порівняйте отримані значення пористості та проникності для різних шарів і 

виявлення зон, що потенційно можуть бути продуктивними. 

o Оцініть насиченість флюїдами і визначте, які горизонти можуть бути 

потенційно водоносними або нафтовими. 

5. Інтерпретація результатів: 

o Проаналізуйте, як отримані петрофізичні характеристики впливають на 

розподіл ресурсів і можливість їх видобутку. 

o Використовуйте моделювання для прогнозування продуктивності родовищ 

нафти, газу або води, а також для визначення перспективи подальших 

розвідок і розробки. 

6. Візуалізація результатів: 

o Створіть візуальні моделі або графіки, що відображають пористість, 

проникність, насиченість флюїдами для різних геологічних тіл або родовищ. 

o Для зручності інтерпретації можна побудувати 3D моделі геологічних шарів 

з зазначенням фізичних характеристик. 

7. Оформлення результатів: 

o Підготуйте звіт за результатами практичної роботи, в якому будуть наведені 

графічні матеріали, таблиці з отриманими результатами, інтерпретація 

моделей. 



o Звіт повинен містити короткий опис методів моделювання, розрахунки, 

висновки щодо потенціалу родовища та рекомендації для подальших 

досліджень. 

Примітка: Петрофізичне моделювання є важливим для оцінки економічної ефективності 

розробки родовищ природних ресурсів. Одержані моделі дозволяють з високою точністю 

прогнозувати продуктивність геологічних об'єктів та оптимізувати процеси видобутку. 

  

Практична робота № 16 

Підрахунок запасів. Створення контактів між флюїдами 

Мета: Ознайомитися з методами підрахунку запасів корисних копалин (нафти, газу, води) 

та створення контактів між флюїдами для моделювання їх розподілу в геологічних тілах. 

Завдання: 

1. Оцінити запаси нафти, газу чи води в родовищі за допомогою геофізичних та 

петрофізичних даних. 

2. Створити контакти між флюїдами (нафтою, газом і водою) у геологічних моделях з 

урахуванням параметрів родовища. 

3. Виконати розрахунки запасів корисних копалин, використовуючи геофізичні дані. 

Теоретичні положення: 

1. Підрахунок запасів — це процес оцінки кількості корисних копалин (нафти, газу, 

води), що зберігаються в родовищі, на основі геофізичних, геологічних і 

петрофізичних даних. Оцінка запасів включає визначення об'ємів рідких та газових 

флюїдів в різних геологічних горизонтах. 

2. Контакти між флюїдами — це визначення меж розташування різних флюїдів 

(нафта, газ, вода) в породах, що складають родовище. Контакт флюїдів важливий 

для створення більш точної моделі родовища і для прогнозування його 

продуктивності. 

3. Підрахунок запасів і створення контактів між флюїдами здійснюється на основі 

глибокого аналізу даних, таких як пористість, проникність, насиченість флюїдами і 

глибина розташування цих горизонтів. 

Порядок виконання: 

1. Імпорт даних: 

o Завантажте каротажні дані, інформацію про пористість, проникність, 

насиченість флюїдами та глибину геологічних горизонтів. 

o Переконайтеся в коректності даних та їх сумісності з програмним 

забезпеченням (наприклад, Schlumberger Petrel або ArcGIS). 

2. Моделювання контактів між флюїдами: 

o Використовуйте спеціалізоване ПЗ для моделювання флюїдів у родовищі 

(Schlumberger Petrel, ArcGIS або інші аналоги). 

o Створіть геологічну модель, яка відображатиме розподіл нафти, газу та води 

у різних шарах. 

o Визначте межі контактів між флюїдами, тобто рівні, на яких переходить 

один тип флюїду в інший. 



3. Підрахунок запасів: 

o Використовуючи дані про пористість та проникність, розрахуйте об'єм 

флюїду в кожному геологічному горизонті. 

o Для кожного горизонту визначте, який обсяг флюїду може бути збережений, 

виходячи з даних про насиченість флюїдами та пористість. 

o Для обчислення запасів використовуйте формулу для підрахунку запасів у 

нафтових та газових родовищах: 

V=A⋅h⋅ϕ⋅SwV = A \cdot h \cdot \phi \cdot S_wV=A⋅h⋅ϕ⋅Sw 

де: 

o VVV — об'єм запасів; 

o AAA — площа горизонту; 

o hhh — потужність горизонту; 

o ϕ\phiϕ — пористість; 

o SwS_wSw — насиченість флюїдом (нафта, газ, вода). 

4. Інтерпретація результатів: 

o Проаналізуйте отримані дані, щоб визначити, які горизонти є потенційно 

найбільш продуктивними. 

o Оцініть, як зміна параметрів (пористість, проникність, насиченість 

флюїдами) впливає на загальні запаси в родовищі. 

o Виконайте прогноз запасів для різних сценаріїв розробки родовища. 

5. Візуалізація результатів: 

o Побудуйте 3D-моделі, що відображають розподіл флюїдів у різних 

горизонтах родовища. 

o Використовуйте графічні методи для демонстрації контактів між флюїдами 

та загальних запасів нафти, газу або води. 

6. Оформлення результатів: 

o Оформіть звіт, що містить графіки, таблиці, моделі з підрахованими 

запасами, а також інтерпретацію даних. 

o Вказати точні контакти між флюїдами, обсяг запасів і рекомендовані 

стратегії для подальших досліджень або розробки родовища. 

Примітка: Контакти між флюїдами і підрахунок запасів є критично важливими етапами в 

оцінці потенціалу родовища, адже вони дозволяють прогнозувати не тільки кількість 

ресурсів, а й їх подальше видобуток. Розуміння геофізичних характеристик допомагає 

приймати обґрунтовані рішення щодо технологій видобутку і оптимізації процесів 

розробки родовища. 

 

Практична робота № 17 

Проектування свердловин 

Мета: Ознайомлення з процесом проектування свердловин для видобутку корисних 

копалин, нафти чи газу. Розробка параметрів свердловини, з урахуванням геологічних, 

геофізичних і технологічних вимог. 

Завдання: 



1. Розробити проект свердловини на основі геологічних, геофізичних та 

технологічних даних. 

2. Визначити оптимальну траєкторію свердловини для досягнення максимальних 

результатів видобутку. 

3. Прорахувати необхідні параметри свердловини, такі як діаметр, глибина, витрати 

та інші важливі характеристики. 

Теоретичні положення: Проектування свердловини є ключовим етапом в освоєнні 

родовища корисних копалин, зокрема для видобутку нафти та газу. Основними 

параметрами проектування свердловини є її глибина, діаметр, траєкторія, способи буріння 

та матеріали, що використовуються. 

1. Геологічне проектування свердловини: Перед початком проектування необхідно 

провести детальний аналіз геологічних умов родовища, включаючи визначення 

товщі корисних копалин, геофізичних характеристик, таких як пористість, 

проникність, глибина залягання та інші. 

2. Технологічне проектування свердловини: Процес проектування включає вибір 

найбільш ефективної технології буріння, визначення необхідної кількості і типу 

бурових рідин, визначення режиму буріння та типу обладнання. 

3. Проектування траєкторії свердловини: Визначення оптимальної траєкторії для 

забезпечення максимальної продуктивності та безпеки буріння. Це включає 

розрахунок кута нахилу, глибини, а також можливість буріння горизонтальних та 

похилих свердловин. 

Порядок виконання: 

1. Імпорт даних: 

o Завантажте геологічні, геофізичні та технологічні дані, необхідні для 

проектування свердловини. Це можуть бути дані про товщі, наявність 

водоносних шарів, газоносні та нафтоносні горизонти, а також про 

геофізичні характеристики, такі як пористість і проникність. 

o Перевірте дані на наявність неточностей і коректність, необхідно провести 

попередню обробку для створення моделі родовища. 

2. Аналіз геологічних даних: 

o Використовуйте отриману інформацію для створення профілю родовища. 

Оцініть товщі, що підлягають розробці, і виберіть найбільш перспективні 

горизонти для буріння. 

o Визначте рівень залягання корисних копалин, а також глибину, на якій буде 

здійснюватися видобуток. 

3. Проектування свердловини: 

o Використовуючи дані про родовище, розробіть параметри свердловини. 

Розрахуйте глибину свердловини, її діаметр, тип і кількість бурових рідин, а 

також кількість обладнання для процесу буріння. 

o Сплануйте траєкторію свердловини. Визначте, чи буде це вертикальна, 

похила чи горизонтальна свердловина. Прорахуйте необхідний кут нахилу 

для оптимальної траєкторії. 

4. Моделювання свердловини: 

o Використовуйте спеціалізоване програмне забезпечення для моделювання 

бурових процесів (наприклад, Petrel, ArcGIS). 

o Створіть 3D-модель свердловини, яка включатиме геологічні шари, 

траєкторії буріння, а також бурові рідини та інші технологічні параметри. 

5. Оцінка безпеки та ефективності: 



o Оцінюйте стабільність шурфа, ризики обрушення стінок свердловини, 

можливість проникнення в інші горизонти. Враховуйте технічні можливості 

обладнання. 

o Проводьте аналіз ризиків з урахуванням геологічних і технологічних 

особливостей родовища, для оцінки можливих втрат, аварійних ситуацій. 

6. Підготовка проекту свердловини: 

o Сформулюйте рекомендації щодо вибору обладнання для буріння та 

безпечного проведення робіт. 

o Оформіть звіт з проектування свердловини, що включатиме: 

▪ Опис геологічних і технологічних умов. 

▪ Розрахунок параметрів свердловини. 

▪ Моделі, діаграми та графіки з візуалізацією траєкторії буріння. 

▪ Оцінку безпеки та ефективності виконання робіт. 

7. Візуалізація результатів: 

o Створіть графіки і схеми, що зображають траєкторію свердловини, її 

параметри, а також прогнозовану продуктивність. 

o Побудуйте 3D-модель свердловини в інтерактивному програмному 

середовищі для демонстрації клієнту або керівництву. 

8. Оформлення документації: 

o Оформіть звіт, який включатиме детальний опис кожного етапу 

проектування свердловини, а також результати аналізу і моделювання. 

o Підготуйте таблиці і графіки з розрахунками запасів, параметрів 

свердловини та інших технічних даних. 

Примітка: Проектування свердловин є важливим етапом в розробці родовищ корисних 

копалин, оскільки правильне планування може суттєво вплинути на ефективність 

видобутку та знизити ризики виникнення аварій або технічних проблем під час буріння. 

Залучення сучасних методів моделювання та аналізу дозволяє значно поліпшити якість 

проектування та знизити витрати на бурові роботи. 

 

Практична робота № 18 

Створення карт та розрізів для друку 

Мета: Ознайомлення з процесом створення картографічних матеріалів, таких як карти та 

геологічні розрізи, які підготовлені для друку. Оволодіння навичками використання 

сучасного програмного забезпечення для створення карт та розрізів, а також 

форматування їх для друкованої продукції. 

Завдання: 

1. Створити карту (географічну, геологічну, топографічну тощо) з використанням 

векторних та растрових даних. 

2. Розробити геологічний розріз на основі геологічних даних. 

3. Визначити параметри карт та розрізів, необхідні для їх подальшого друку, з 

урахуванням стандартів і вимог. 

4. Підготувати картографічні матеріали для виготовлення друкованої продукції. 

Теоретичні положення: 



1. Картографія — наука, яка займається створенням карт та іншої графічної 

документації, що відображає різноманітні географічні, геологічні, екологічні та 

інші характеристики земної поверхні. 

2. Типи карт: 

o Топографічні карти — відображають рельєф, водні ресурси, населені 

пункти та інші об'єкти. 

o Геологічні карти — показують розподіл геологічних порід на поверхні 

земної кори, їх склад, вік, структуру. 

o Температурні карти — відображають температурні поля в певних 

регіонах. 

3. Геологічні розрізи — графічне зображення вертикального розрізу через геологічні 

шари, яке дає уявлення про структуру підземних порід на певній ділянці земної 

поверхні. 

4. Основні етапи створення карти та розрізу: 

o Імпорт даних: необхідно завантажити географічні та геологічні дані, що 

містять інформацію про рельєф, геологічну будову тощо. 

o Обробка даних: виконати редагування даних, створити необхідні шари для 

карти, вибрати стиль відображення даних. 

o Побудова карти/розрізу: застосування інструментів програмного 

забезпечення для створення чіткої та зрозумілої карти/розрізу. 

o Форматування для друку: визначити масштаби, додавати легенди, підписи 

та інші елементи, необхідні для виготовлення якісної друкованої карти. 

5. Інструменти програмного забезпечення: 

o ArcGIS — для створення карт та обробки географічних даних. 

o QGIS — відкритий програмний засіб для створення карт, аналітики та 

візуалізації даних. 

o AutoCAD — для підготовки розрізів та іншої детальної геологічної 

документації. 

o Adobe Illustrator — для оформлення карт до друку з високою точністю. 

Порядок виконання: 

1. Імпорт даних: 

o Завантажте необхідні дані для створення карти або розрізу. Це можуть бути 

як векторні, так і растрові дані, що містять географічні або геологічні 

відомості про досліджувану територію. 

o Для геологічного розрізу використовуйте дані про геологічні шари, їх склад, 

товщину і глибину залягання. 

2. Обробка даних: 

o Виберіть відповідні шари для карти чи розрізу. Для картографічних 

матеріалів це можуть бути шари рельєфу, гідрографії, адміністративного 

поділу. 

o Для геологічного розрізу визначте шари порід та інші параметри, необхідні 

для візуалізації. 

3. Створення карти або розрізу: 

o Карта: Оберіть відповідний стиль для кожного шару, використовуючи 

кольори та умовні позначення для рельєфу, водних ресурсів, населених 

пунктів і т. п. 

o Геологічний розріз: Визначте глибину кожного шару, його склад, вік, а 

також застосуйте кольори та текстури для кращого візуального сприйняття. 

o Використовуйте інструменти програмного забезпечення для налаштування 

масштабу, підписів, легенди та інших елементів карти/розрізу. 



4. Оптимізація карти для друку: 

o Визначте розмір аркуша для друку. Для цього необхідно налаштувати 

розмір і орієнтацію сторінки. 

o Задайте правильний масштаб, що забезпечить точне відображення 

географічних або геологічних особливостей на карті. 

o Додайте легенду, підписи, напрямок півночі, пояснення умовних позначень, 

щоб карта була зрозумілою користувачеві. 

5. Форматування для друку: 

o Перевірте всі елементи карти на наявність необхідної інформації (підписи, 

легенди, координати). 

o Виберіть відповідний формат для збереження карти для друку (наприклад, 

PDF або TIFF). 

o Перед створенням фінальної версії карти, здійсніть її попередній перегляд 

для виявлення можливих помилок у відображенні інформації. 

6. Експорт готових карт та розрізів: 

o Експортуйте карту або розріз у формат, що підходить для друку (PDF, TIFF, 

JPEG). 

o Переконайтеся, що всі шари карти збережені і відображаються в кінцевому 

документі. 

o За необхідності підготуйте декілька версій карти в залежності від формату 

друку (наприклад, A3, A4, постер). 

7. Перевірка якості друку: 

o Перед друком перевірте якість картографічних матеріалів на відповідність 

вимогам масштабів, якості зображення, чітких підписів та інших параметрів. 

o Проведіть тестовий друк на малому форматі для оцінки результатів. 

8. Оформлення та подача роботи: 

o Оформіть проект відповідно до вимог інструкцій. 

o Представте готову карту або розріз для здачі роботи, прикріпивши 

пояснювальну записку з описом виконаних етапів. 

Примітка: Створення карт та геологічних розрізів для друку є важливою складовою в 

підготовці картографічних та геологічних матеріалів для досліджень та публікацій. 

Правильне використання програмного забезпечення дозволяє ефективно відображати 

географічні та геологічні дані, що забезпечить точність і зрозумілість для кінцевих 

користувачів. 

 

 

  



ВАЖЛИВО! 

При відсутності доступу до ліцензійного програмного забезпечення треба використовувати 

перегляд відео контенту (туторіалів) що надаються викладачем. Відеоконтент було записано на 

ліцензійному програмному забезпеченні з використанням усіх ліцензійних вимог. 

Посилання на відеоконтент надаються студентам викладачем у чаті або листі при листуванні. 

Запитати посилання можна за номером телефону +380632434380 



Приклади екзаменаційних питань  

40 залікових балів 

Питання з одним варіантом правильної відповіді (по 2 б за правильну відповідь) 

1. Яке програмне забезпечення використовують для моделювання геофізичних 

процесів? 

а) ArcGIS 

б) Schlumberger Petrel 

в) AutoCAD 

г) QGIS 

2. Який метод використовують для побудови картографічних матеріалів? 

а) Метод математичних розрахунків 

б) Метод інтегрованого моделювання 

в) Метод ГІС 

г) Метод геометричного моделювання 

3. Яка з перелічених характеристик визначає міцність гірських порід при 

проектуванні свердловин? 

а) Товщина порід 

б) Пористість порід 

в) Механічні властивості порід 

г) Глибина залягання порід 

4. Який інструмент є основним для розрахунку запасів корисних копалин за 

допомогою геофізичних методів? 

а) Порівняльний аналіз 

б) Геофізичне моделювання 

в) Статистичний аналіз 

г) Блок-схеми 

Питання з множинним вибором (по 2 б за кожний правильний варіант відповіді) 

5. Які програмні продукти можна використовувати для створення геологічних карт? 

а) ArcGIS 

б) QGIS 

в) Microsoft Excel 

г) Schlumberger Petrel 

д) AutoCAD 

6. Які фактори можуть впливати на якість геофізичного моделювання? 

а) Точність вхідних даних 

б) Кількість використаних інструментів 

в) Глибина моделювання 

г) Потужність комп'ютера 

д) Рівень візуалізації результатів 

Питання на встановлення відповідності (по 1 балу за кожну правильно встановлену 

відповідність) 

7. Поставте у відповідність типи моделей та їх використання: 

1. Геометричне моделювання 

2. Геофізичне моделювання 



3. Сейсмічне моделювання 

а) Оцінка швидкості поширення хвиль в середовищі 

б) Розрахунки резервуарів підземних вод 

в) Аналіз просторової конфігурації об'єктів 

Відповідь: 

1 ___, 2 ___, 3 ___ 

Питання з короткою відповіддю (по 2 бали за кожну правильно вписану відповідь) 

8. Що таке «петрофізичне моделювання»? 

9. Опишіть принцип роботи методу «підрахунку запасів» у геофізичному 

моделюванні. 

10. Як визначають геометричні властивості порід у процесі геофізичних досліджень? 

11. Які методи використовуються для розробки свердловин у геофізичному 

моделюванні? 

Питання з розгорнутою відповіддю (по 5 балів) 

12. Охарактеризуйте процес створення геологічного розрізу в геофізичному 

моделюванні. Які етапи включає цей процес? 

13. Поясніть, як за допомогою геофізичних методів проводиться оцінка запасів 

корисних копалин. 

14. Як методи геофізичного моделювання можуть бути використані для визначення 

розташування розломів на території? 

15. Розкрийте зміст геофізичних та петрофізичних моделей у контексті моделювання 

геологічної будови. Які переваги ці методи надають при проектуванні свердловин? 

Загальна сума балів: 40 балів 

Час на виконання завдання: 1 година 30 хвилин (90 хвилин) 

 



Розгорнутий план лекцій до дисципліни Комп’ютерне моделювання в геології 

Лекція 1: Вступ. ГІС та ГГІС. Принципи роботи. У цій лекції розглядаються основи 

Геоінформаційних систем (ГІС) та ГеоГрафічних Інформаційних Систем (ГГІС). Окрема 

увага приділяється принципам роботи з геоінформацією, алгоритмам обробки 

просторових даних та основним поняттям. Визначаються типи ГІС, їхня структура, 

компоненти та функціональні можливості. Студенти ознайомлюються з призначенням та 

можливостями ГІС для аналізу та прийняття рішень у геології та інших суміжних науках. 

Лекція 2.1: ГІС на прикладі пакету програмного забезпечення ESRI ArcGIS (Частина 

1). Ця лекція присвячена пакету ESRI ArcGIS. Студенти дізнаються про основні 

інструменти та інтерфейс користувача, а також про принципи роботи з растровими 

зображеннями. Окремо розглядається обробка растрових даних і використання 

атрибутивних таблиць для зберігання та управління даними, що забезпечує гнучкість і 

точність в аналізі просторових об'єктів. 

Лекція 2.2: ГІС на прикладі пакету програмного забезпечення ESRI ArcGIS (Частина 

2). У цій лекції акцент робиться на розширених інструментах ArcGIS, таких як трасування 

зображень за допомогою штатних та зовнішніх програм. Вивчаються методи створення та 

редагування баз даних, включаючи роботу з різними типами інформації, що дозволяє 

користувачам організувати великі масиви просторових даних для подальшого 

використання в різних типах аналізу.  

Лекція 3.1: ГГІС на прикладі пакету програмного забезпечення ArcGIS (Частина 1). 

Ця лекція присвячена роботі з горизонтами та методам розбивки простору на зони і шари. 

Розглядаються інструменти глибинного перетворення даних для створення тривимірних 

моделей геологічної поверхні. Також вивчаються методи моделювання геометричних 

властивостей, що є основою для точного аналізу геологічних структур. 

Лекція 3.2: ГГІС на прикладі пакету програмного забезпечення ArcGIS (Частина 2). 

У лекції розглядаються питання моделювання фацій та петрофізичних властивостей, а 

також підрахунку запасів корисних копалин. Окрему увагу приділено створенню карт та 

розрізів для друку, що є важливими інструментами для наукових досліджень та розробки 

проектів у галузі геології та гірництва. 

Лекція 4: ГГІС на прикладі пакету програмного забезпечення Schlumberger Petrel 

(Частина 1). Лекція присвячена інтерфейсу користувача програми Schlumberger Petrel та її 

основним функціям. Студенти дізнаються, як імпортувати дані, перевіряти їхню якість, а 

також редагувати вхідні дані для подальшої обробки. Розглядаються ключові інструменти 

для аналізу геофізичних даних, які використовуються в геологічних дослідженнях. 

Лекція 5: ГГІС на прикладі пакету програмного забезпечення Schlumberger Petrel 

(Частина 2). У цій лекції акцент робиться на візуалізацію каротажних діаграм, кореляцію 

свердловин та моделювання геологічних розломів. Студенти отримають уявлення про 

методи, які дозволяють отримувати наочні геологічні моделі та кореляційні аналізи для 

точного визначення геофізичних характеристик території. 

Лекція 6: Каротажні діаграми та робота з ними за допомогою програмного 

забезпечення «Каротаж софт». Ця лекція присвячена роботі з каротажними діаграмами в 

програмному забезпеченні «Каротаж софт» ОПИУМ та Карпати. Студенти вивчатимуть 

методи імпорту та експорту даних, обробку кривих, створення літологічних колонок та 

цифрову інтерпретацію каротажних даних. Це дозволяє створювати детальні моделі 



підземних геологічних структур та аналізувати їх для подальшого використання в 

геологічних розвідках. 

 


